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Getting Started

Disk Copy 6.1.2 isautility application that will mount disk images on your
desktop, make exact copies of fl oppy disks from a disk image, convert disk images
from one format to another, and create a disk image from a mounted volume or
individual folder. Using DiskScripts and AppleScript, it can be used to automate
software installations and disk image manipulation.

System requirements and supported features

Disk Copy 6.1.2 requires System Software 7.0.1 or later and isa“fat binary” for
both PowerPC and 68K -based Mac OS compatible computers. M acintosh
Application Environment 3.0 Update 4 or later is also supported; A/UX is not
supported. Disk Copy 6.1.2 features extensive Balloon Help and supports Drag and
Drop (requires System Software 7.5 or later), AppleScript, PlainTa k Text-to-
Speech, and DigiSgn digital signatures.

Installing Disk Copy 6.1.2

Disk Copy 6.1.2 can reside anywhere on your hard disk. It is recommended to place
an aliasto it on the desktop for easy access.

Disk Copy 6.1.2 requires the ObjectSupportLib and AppleScriptLib extensions on
PowerPC-based computers (they are included in a standard System Software
install). These files can be located in the Extensions folder of the System Folder or
in the same folder as Disk Copy 6.1.2.

Remove any copies of Disk Image Mounter and Disk Copy 6.0.1

Disk Copy 6.1.2 provides all the functionality of Disk Image Mounter, a utility that
was included with some PowerBook models. Disk Copy 6.0.1 wasreleased only to
developers and Support Professional Solution Series subscribers To avoid
problems working with disk images, it isimportant to remove all copies of both
Disk Image Mounter and Disk Copy 6.0.1 and rebuild your desktop after installing
Disk Copy 6.1.2. If you have upgraded from Disk Copy 6.1, you may also want to
rebuild your desktop; some of the iconsin Disk Copy 6.1.2 have been revised.

While Disk Copy 6.1.2 also features the functionality of Disk Copy 4.2 and Fl oppy
Disk Maker, neither of these utilities will interfere with Disk Copy 6.1.2 and do not
need to be removed.
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Disk Copy 6.1.2 Basics

About disk images

A disk image is a discrete e ectronic representation of an individual volume; the
image contains all the information to make an exact duplicate of the original. A
copy made by dragging icons is not an exact copy; there may be invisible filesor
other i nformation that is not copied. When you use disk images, the volume asa
whole has been duplicated correctly and completely.

Making disk images of floppy disksis also a convenient and safe way to make
backups of original master disks from purchased software packages and allows you
to electronically di stribute the contents of disks.

Disk image formats

Disk Copy 6.1.2 can read and write three types of NDIF (New Disk |mage Format)
disk images, Disk Copy 4.2 disk images, as well as read other disk image formats.

Format Description
Disk Copy 6.1.2can  Read/Write [ L, Disk images in this format will allow you to make changes when mounted as if
read NDIF disk  NDIF ] they were actual floppies or hard disks. Disk image size for this format can vary
images created by || from a minimum of 401K to a maximum of 2GB.
Disk Copy 6.0.1, but R R, R S e
NDIF disk images Read-Only [a I Disk images in this format will allow you to open files and run applications when
created by Disk Copy NDIF ] mounted, but not make any changes as if they were locked floppy disks or
6.1 or 6.1.2 are not [ CD-ROMs. Read-Only image format is similar to disk image formats you may
backwards have worked with previously, except it truncates any empty space, resulting in
compatible. smaller disk images, and disk image size can vary from a minimum of 401K to a
maximum of 2GB. This format also includes a checksum.
Read-Only o Disk images in this format function the same as Read-Only but in addition to
Compressed uil truncating any empty space, the Read-Only Compressed format compacts the
NDIF | data in the disk image, resulting in even smaller disk images. Disk Copy 6.1.2

provides extremely fast decompression so the only extra time necessary is
during compression. This format is a good choice for disk images that will be
downloaded. Disk image size for this format can vary from a minimum of 401K
to a maximum of 2GB and includes a checksum. Macintosh Plus, SE, Classic,
Portable, and PowerBook 100 computers can mount and make floppies from,
but cannot create, a Read-Only Compressed format disk image.

Disk Copy 4.2 Disk images in this format work the same as the Read-Only format but are
L compatible with the previous version of Disk Copy and many third party disk
image utilities. Disk Copy 4.2 format only supports 720K, 800K, and 1.4MB
floppy sizes. This format also includes a checksum.

continues »
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Format Description

PC Drive Disk Copy 6.1.2 will mount as read/write, but does not create disk images in this
Container PC format. Container files are created by Apple’s PC Compatibility software, which
- works only on DOS-Compatible Mac OS computers.

DART Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
& images in this format. DART is an older Apple utility for working with disk images
which creates compressed disk images.
ShrinkWrap [= I, Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
Floppy L images in this format. ShrinkWrap (versions 2.1 and earlier) floppy format is
0 nearly identical to Disk Copy 4.2 format.

ShrinkWrap = Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
Volume T images in this format. ShrinkWrap (versions 2.1 and earlier) volume disk
images are not floppy size and do not have a checksum.

DOS and ProDOS-formatted disk images

Disk Copy 6.1.2 requires PC Exchange to work with disk images that contain DOS
or ProDOS volumes, such as a PC drive container or a DOS-formatted floppy.

To make DMF (a1.7 MB PC format) floppies, Disk Copy requi res a SuperDrive
and Mac OS 7.6 or later, which i ncludes PC Exchange version 2.1.1 or later.

Mounting disk images

Instead of making floppies from disk images to copy files or install software, for
example, Disk Copy 6.1.2 allows you to have disk images appear on the desktop as
if you had made a floppy and inserted it into the floppy drive.

Mounting is also the only way to work with disk images that are larger than a
floppy. Working with mounted disk images is as fast as working with a hard drive
and you no longer need a stack of floppies.

Verification and authentication

Disk Copy 6.1.2 supports two methods to ensure the integrity of disk images:
checksums and digital signatures.

A checksum is a number derived from looking at the data that makes up the disk
image. It is stored in the disk image itself. If any changes are made to the disk
image, the checksum will change as well. When Disk Copy 6.1.2 begins to work
with adisk image, it can optionally verify that checksum has not changed to ensure
no data corruption or alteration has occurred.

Digital signatures are used to approve, or “sign,” files to assure its authenticity.
DigiSign software is part of, but does not require, ApplésPowerTak software

The checksum allows Disk Copy 6.1.2 to verify the contents of a disk image, while
the signature allows authentication of the source of the disk image.

Disk Copy 6.1.2 Basics 3



Disk Copy 6.1.2 main window

Disk Copy ————"o—————

File name of the last |
disk image, the name
of the volume within
it, the validity of the
checksum, and if the
DigiSign extension is

— Irnage Mame -

“olurne Mame : -—
Check=um: -—
CrigiSign™ ; -

installed, the digital
signature status.

Results of the last __|

action performed.

To mount a dizk image, drag it to thiz window or zelect “Mount Image * from the
Irnage reny. Once an irmage is mounted , you can woark with it a2 gou would any
disk on the desktop.
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Image and volume name

These lines show the file name of the disk image last operated on and the name of
the volume contained within the disk image, respectively.

Checksum status

The checksum line will display one of the following messages:

= “VALID ([image type] calculated [checksum])”: The selected disk image has
not been altered or damaged and is safe to use

= “INVALID ([image type] expected [checksum])”: A checksum fails usually
because the disk image is corrupt. Disk Copy 6.1.2 will most likely warn you the
image is damaged and cannot be used instead of displaying this message.

= “not checked ([image type] expected [checksum])”: The Verify Checksum
option is deselected in the Preferences dialog box.

= “none”: Many other disk image utilities do not add a checksum to some disk
images they create. This does not mean the disk image is corrupt; there is
simply no way to verify itsintegrity.

DigiSign status
The DigiSign line will appear if the DigiSign extension is installed and display
one of the following messages:

s “VERIFI ED”: The selected image has not been altered since it was signed. T his
line will also indicate if the signer has expired (signatures must be renewed).

= “INVALID": The selected image has been altered since it was signed.

= “signed, not checked’: The disk image is signed, but the Verify Signature option
is deselected in the Preferences dial og box.

= “not signed”: The disk image does not have a digital signature.



Using Disk Copy 6.1.2

Mounting disk images

1

Click to verify the
checksum of the
selected disk image.
If the checksum fails,
the disk image will
not be mounted.

Click to verify the
signature of the
selected disk image.
If the signature is
invalid, the disk
image will not be
mounted.

To mount a disk image, do any of the following:

= Select one or more disk images and double-click. Thisonly works for NDIF

images (Read/Write, Read-Only, and Read-Only Compressed).

= Select one or more disk images and drag into the Disk Copy 6.1.2 main window

(requires System Software 7.5 or later).

= Select one or more disk images and drag onto the Disk Copy 6.1.2 application

icon.

= Choose “Mount Image..” from the Image menu and select a disk image.

Select the image to mount:

= Disk Copy Files ¥

Disk Copy 4.2
Disk Copy NDIF Read-0nly

Disk Copy NOIF Read-0Only Comp
Disk Copy NDIF Read/Write

[@ DART

o>

<

[<] Verify Checksum
[<] Verify Signature

=— Disk Copy

[

Eject |

[ Desktop ]

[ Cancel ]

After adisk image is selected, Disk Copy 6.1.2 will present a progress dialog for
mounting and checksum verification (if the option is selected), and an icon for the

mounted volume will appear on the desktop.

____lcon for the volume contained

=1
sk Tools

in the disk image as shown
mounted on the desktop.

Using Disk Copy 6.1.2 5



Y ou can now work with the mounted volume as you would any regular volume. To
unmount, either drag the icon to the Trash or select the icon and use the “ Put
Away” command from the File menu. When you restart you computer, any
mounted disk images will be unmounted.

2 To see how your computer recognizes the data on the mounted volume, select the icon for the
mounted volume in the Finder and choose “Get Info” from the File menu.

=[I=—— Disk Tools Info —rr—
Ol]| pisk Tools | The“Kind” and “Size”
3 . items appear as they
K!“d: disk . would for any floppy,
Size: 1.32 ME on disk (1,426 432 bytes hard disk, or CD-
used), for 2 items ROM, but the
Yhere: Dizk Toolz, Image file 1.4 ME Dizk “Where” item shows
Irmage * on wolure “Disk Copy ™. that the volume “Disk
Tools” is contained in
Created: wed, Jan 24, 1996, Z:21 AM the disk image “1.4
HModified : ‘Wed, Jan 24, 1996, 322 AM MB Disk Image”
Comments - which is on the
: volume “Disk Copy.”

In the example below, you can see how a mounted disk imageisa*“virtual disk” to
your computer. What looks like a disk on the desktop is actually a disk image.

=0=——— Disk Copy =——[11= N
Data that appears on 4 jtems S63 ME in disk 749 ME availd
the mounted volume D .
“Disk Tools” is e | = |
actually in the disk |— 1]
image named “1.4 L |
MB Disk Image,” Systern Folder 1.4 MB Disk Irmage ﬂ,
which is on the hard {::'l |E:::- P:.. Jeff-0-Fama
disk volume “Disk =
Copy,” soreading 1= - —
andwiting datato  [Ell—e—c———=— Disk Tools =———H8I= J
and from the . L . ;
mounted image wi m Zitems 1.2 MB in disk 134K awvailable Dvisk Tools
be as fast as from the g
hard disk. ée] =
— [t
Apple HD SC Setup Cizk First did {!?
< EE
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Making floppies from disk images

1 To make a floppy from a disk image, do any of the following:

» Select one or more disk images and double-click while pressing the Option key.
This only works for NDIF images (Read/Write, Read-Only, and Read-Only
Compressed).

= Select one or more disk images and drag into the Disk Copy 6.1.2 main window
while pressing the Option key (requires System Software 7.5 or later).

» Select one or more disk images and drag onto the Disk Copy 6.1.2 application
icon while pressing the Option key.

= Choose “Make aFloppy...” from the Utilities menu and select adisk image.

5elect the image to make a floppy:

o Disk Copy Files ¥ — Disk Copy
Disk Copy 4.2 &ty [ Eject |
Disk Copy NDIF Read-0nly
Disk Copy NDIF Read-Only Comp [_Desktop |
When making Disk Copy NDIF Read/Write
floppies, Disk Copy
always verifies the @ DART [ Cancel ]
checksum of the
selected disk image. |
If the checksum fails, 4L

the floppy will not be
made. [<] Verify Checksum

Click to verify the E ”Erifu Sig“ﬂture
signature of the

selected disk image.
If the signature is ) ] ) ] ) o
invalid, the floppy will - Only images that contain floppy-size volumes will appear in this dialog box; larger

notbe made.  gize volumes can only be mounted or converted.

Disk Copy 6.1.2 requires PC Exchange to make floppies from disk images that
contain DOS or ProDOS volumes, such as a PC drive contai ner or a DOS-
formatted floppy.

To make DMF (a1.7 MB PC format) floppies, Disk Copy requi res a SuperDrive
and Mac OS 7.6 or later, which i ncludes PC Exchange version 2.1.1 or later.

After adisk imageis selected, Disk Copy 6.1.2 will present a progress dialog for
checksum verification and ask you for afloppy that is the same size as the disk
image. Y ou cannot, for example usea 1.4 MB fl oppy to make an 800K volume.

When making floppies, Disk Copy 6.1.2 uses more memory that its default memory
setting. If thereis not free RAM available, Disk Copy 6.1.2 will not be able to make
the floppy and will present an error message. Either quit other running
applications or increase Disk Copy’s Preferred memory size to 2048K.

Using Disk Copy 6.1.2 7



.= Making “Disk Tools” from image file

+ - “1.4 MB Disk Image”...

iE
14

Please insert a high-density floppy.

[ Stop ]

Click Stop or press
Command-Period or the
Esc(Escape) key to stop.

If you insert afloppy that has been previously formatted and the Confirm Erases
option is selected in the Preferences dialog box, Disk Copy 6.1.2 presents a dialog
box asking you to confirm before erasing the floppy and copying new datato it.

Are you sure Yyou want to erase “Rob’s
Work™ and replace its’ contents with

“Disk Tools"”?

Click Cancel or press
Command-Period or
the Esc (Escape) key

oo || {Cancel

Click Yes or press Command- Click or press Return or
Shift-Y to erase the disk and Enter to eject the current
copy new data to it. floppy and use another.

2  Click the appropriate button to proceed or cancel.

=——————— Making fFloppy =—"——

Initializing and copying...

SOOI

Disk Copy 6.1.2 will gect the floppy when it is finished. If the Make Multiple
Floppies option is selected in the Preferences dial og box, Disk Copy 6.1.2 will
present a dialog box asking for the next floppy to make.

8 : Chapter 3



Creating disk images

1 To create a disk image, do any of the following:

= Select one or more folders or disks and drag into the Disk Copy 6.1.2 main
window (requires System Software 7.5 or later). Each folder and disk will be
made i nto a separate disk image.

= Select one or more folders or disks and drag onto the Disk Copy 6.1.2
application icon. Each folder and disk will be made into a separate disk image.

= Choose “Create Image from Fol der...” from the Image menu and select afol der.

S5elect the source folder:

i Disk Copy Files ¥ — Disk Copy

[T Data Folder s [ Eject ]
[ Desktop ]

[ Cancel ]

=
|

[ S5elect “Data Folder”

After afolder is selected, Disk Copy 6.1.2 will calculate the size of the datain the
folder and use that as the default disk image size

Imaging Folder

Estimating size required...

AN

The only exception to thisis folders that contain lessthan 401K of data; the
minimum disk image size is 401K and Disk Copy 6.1.2 will default to that size.
However, saving in either Read-Only or Read-Only Compressed format will result
in adisk image that is closer to the actual size of the data, as both formats tr uncate
out unused space.

Using Disk Copy 6.1.2 : 9



10 :

= Choose “Create Image from Disk...” from the Image menu and select a disk.

Select the source disk:
— Disk Copy ifs
[C]Floppy Disk
Tif Trash
|

— Disk Copy
[ Eject |
[ Cancel ]

= Bring Disk Copy 6.1.2 to the foreground and i nsert a disk.

After adisk or floppy is selected, Disk Copy 6.1.2 defaults to a disk image size the

same as the partition size of the selected volume, which includes unused space.

Press the Shift key when selecting a disk in the dialog box to calculate and show
the amount of datain the disk (excluding free space). This also works when
dragging disk or floppy iconsto the Disk Copy 6.1.2 window or application icon.

2 Type a name and select a format for the new disk image.

== Disk Copy Files ¥ — Disk Copy
Anne's DiskScript [ Eject |
[ T1Data Folder
[E] Disk Copy 4.2 (_Desktop |
[@) Disk Copy NDIF Read-Only | [(New [ |
Set the default disk : _
image name _@ Disk Copy NDIF Read-0nly Comp(4|
extension (“.img” in
this example) in the cave disk iITIEIgE as: [ Cancel ]
Preferences dialog
box. Data Folder.img [[—]Sﬂue ]
Format: | Read-0nly b
Size: 401 K (data size)
[<] Mount Image [<] Add DigiSign™ Signature
Click to mount the new disk Click to add a DigiSign
image after it is saved. signature to the new disk

image after it is saved.
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3

Choose a size for the
new disk image or
select “Custom...” to
specify an exact size.
Only 720K, 800K, 1.4
MB, and 1.7 MB disk
image sizes can be
can be used with the
make floppy feature.

5ave disk image as:

Data Folder.img

Format: ' Read/Write

Read-0nly
Read-0nly Compressed
Disk Copy 4.2

5ize;
(<] Moun

Choose a size for the new disk image.

_ Choose a format for
saving the new disk
image. Use Balloon
Help or see Chapter
1 for more details on
the different formats.

If for example, you want to image a folder with only 300K in it, but need to be
able to use the make floppy feature of Disk Copy 6.1.2, you would need to choose a

standard fl oppy size disk image size

|.I"il.| HInEe > HiIsK3LTIpL

[ T1Data Folder

Disk Copy 4.2
Disk
Disk

-

+« 401 K [da

ta size)

| Eject |

[ Desktop ]
]

120K floppy

save 4l gh0k floppy

Data Fo| 1.4 MB floppy
1.7 MB flo

Format: PRy

cel

e

2.5 MB
10 MB

20 MB

40 MB

160 MB
2 GB

(<] Moun

ature

177,000K (CD-ROM 8 cm)
610,000K (CD-ROM 12 cm)
663,000K (CD-ROM 12 cm, full)

Custom...

When creating disk images from folders with less than 2,051.5K of data, window
and icon position i nformation is not copied. To maintai n wi ndow and icon layout,
choose the “2.5 MB” size for the new disk image.

Using Disk Copy 6.1.2 : 11



Y ou can also specify any size between 401K and 2GB by selecting “ Custom...”
from the Size pop-up menu.

Type the desired disk |ITIEIgE Size: | 401
image size in this

box. Use the pop-up

menu to choose
blocks, kilobytes (K),
or megabytes (MB).

Converting disk images

1 To convert a disk image from one format to another, do any of the following:

= Select one or more disk images and double-click while pressing the Command
key. Thisonly works for NDIF images (Read/Write, Read-Only, and Read-Only
Compressed).

= Select one or more disk images and drag into the Disk Copy 6.1.2 main window
while pressing the Command key (requires System Software 7.5 or | ater).

= Select one or more disk images and drag onto the Disk Copy 6.1.2 application
icon while pressing the Command key.

» Choose “Convert Image...” from the | mage menu and select adisk image.

$elect the image to convert:

“— Disk Copy Files ¥ — Disk Copy
Disk Copy 4.2 < [ ]
Disk Copy NDIF Read-0nly
Disk Copy NDIF Read-0nly Comp [_Desktop |
Disk EDDH NDIF Read/Write| | —————
Click to verify the @ DART I: Cancel ]
checksum of the
selected disk image. ||
If the checksum fails, It Il Open |l

the disk image will
not be converted. (<] Verify Checksum

Click to verify the [<] Verify Signature
signature of the

selected disk image.
If the signature is
invalid, the disk ~ After adisk image is selected, you will see the same standard dialog box that is

image will notbe  presented when creating a new disk image.
converted.

Conversion is actually creating a new image based on the original.
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2 Follow steps 2 and 3 from the previous section, “Creating a disk image.”

Disk Copy 6.1.2 will then create a new disk image based on the selected original
and save it using the size and format options. To make the converted disk image
larger than the original, choose a larger size. To make the converted disk image
smaller than the original, press the Shift key when selecting a disk in the dialog
box to calculate and show the amount of datain the disk (excluding free space).
This also works when dragging disk or floppy icons to the Disk Copy 6.1.2 window
or application icon.

Converting Image

Converting to Disk Copy 4.2 format...

AR AAANAAN

Calculating and verifying checksums

Calculating disk checksums

Disk Copy 6.1.2 dways calculates and includes checksums in the disk images it
creates (except Read/Write format), and can calculate a checksum for avolume
such as afloppy or hard disk. This can be useful if you want to compare a disk
image to its source disk to ensure their contents are identical.

To calculate a checksum for a volume:

Choose “ Calculate Disk Checksum..” from the Utilities menu and select adisk.

Select the disk to checksum:

=— Disk Copy <+ = Disk Copy
[C|Floppy Disk [ Eject
Ti] Trash
[ Cancel ]
[ || S5elect |l

Using Disk Copy 6.1.2 : 13
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The calculated checksum will be displayed in the main window and written to the
log fileif the“ Save Log” option is selected in the Preferences dialog box.

Disk Copy
Irnage Marne -—-
Maolurme Marne -—
Check=ur : NDF caleulated $O808004S
Crigisign™ -—-

The Calculate Checksurm aperation cornpleted successtfully .

Checksums on unlocked volumes are not very useful because any action performed
on the volume will result in a different checksum calculation. Hard disks can be
locked with various formatting utilities, such as Applés Drive Setup.

Verifying image checksums

Verifying the checksum of a disk image helps assure that the file has not been
damaged and is not corrupted. Disk Copy 6.1.2 aways verifies the checksum of a
disk image before making a floppy from it to ensure it is an exact copy.

To verify the checksum of a disk:
» Choose “Verify Image Checksum...” from the Utilities menu and select adisk
image.

= The Mount Image and Convert I mage dialog boxes also have options for
verifying the checksum of a disk image before continuing to work with it.

5elect the image to verify checksum:

=] Disk Copy Files ™ — Disk Copy
Disk Copy 4.2 D [ Eject )
Disk Copy NDIF Read-Only
Disk Copy NDIF Read-0nly Comp [ Desktop |
Disk Copy NDIF Read/Write
|8 DART [ cancel |
=




Disk Copy 6.1.2 will then verify the checksum of the selected disk image. T his can
take a considerable amount of time on large disk images.

Verifying Image Checksum

Uerifying checksum for “1.4 MB Disk
Image®.

| | | Cancel

The status of the checksum will be displayed in the main window and written to
thelog fileif the “Save Log” option is selected in the Preferences dialog box.

If the checksum fails, the disk image may have been altered or damaged.

Signing and verifying digital signatures

These features require the Digi Sign extension. Signing disk images also requiresa
valid Signer file. For more information on digital signatures, see the DigiSign
sections of the PowerShare Server, System 7 Pro, or System 7.5 documentation.

Adding digital signatures to disk images

To add a DigiSign digital signature to a disk image, do any of the following:
= Choose “Sign Image..”” from the Utilities menu and select a disk image.

= The Save | mage dialog box also has options add a digital signature to a disk
image after saving it.

% 5igning as “Fred Green®.
L

DigiSign Identification Code:

(i)

A digital signature will be added to the disk image and it will be locked. Newly
created Read/Write format disk images cannot be signed, because they are altered
by any action, such as mounting.
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Verifying digital signatures

Verifying the signature of a disk image helps assure that the file has not been
atered since it was signed. Thisis helpful for authenticating the source of afile

To verify a digital signature:

Choose “Verify Digital Signature...” from the Utilities menu and select a disk
image.

The Mount Image, Convert | mage, and M ake Floppy dialog boxes also have
options for verifying the digital signature of a disk image before continuing to
work with it.

5elect the image to verify signature:

i Disk Copy Files ¥ — Disk Copy
Disk Copy 4.2 i ]
Disk Copy NDIF Read-0nly
Disk Copy NDIF Read-Only Comp [_Desktop |
I]iSk I:ul]u HI]IF HEﬂd-"llu.lritE .........................................
@“HHT [ Cancel ]
] || Open |l

The status of the signature will be displayed in the main window and written to
thelog fileif the “ Save Log” option is selected in the Preferences dialog box.

About the Disk Copy log

The Disk Copy log wi ndow keeps a detailed record of al activity since the Disk
Copy application was | aunched:

16 : Chapter 3

Each specific action (mount, create, convert, €c.).
The elapsed time and speed (in Kilobytes per second) of each action.
Checksum and digital signature validity information.

The percentage of space savings for disk images saved in Read-Only and Read-
Only Compressed formats.

The results of each action.

To view the log window, choose “ Show Log Window” from the Edit menu.

The contents of the log window can be saved to the “Disk Copy Log” file by
selecting the “ Save Log” option in the Preferences dialog box.



About DiskScripts

Working with DiskScripts and AppleScript

A DiskScript is a special file containing commands that instruct Disk Copy 6.1.2 to
perform an action on alist of disk images, and to optionally launch an application
with or without a specific document. DiskScripts are not related to, and do not
require A ppleScript to run.

Executing a DiskScript

Click to verify the
checksum of all disk
images referenced in
the DiskScript.

To execute a DiskScript, do any of the following:

Select one or more DiskScripts and double-click.

Select one or more DiskScripts and drag into the Disk Copy 6.1.2 main window
(requires System Software 7.5 or later).

Select one or more DiskScripts and drag onto the Disk Copy 6.1.2 application
icon.

Choose “Execute DiskScript...” from the File menu and select a DiskScript.

Select the DiskScript to eHecute:

o Disk Copy Files ¥ — Disk Copy
Anne's DiskScript &ty [ Eject |
Ted's DiskScript

[ Desktop ]
[ Cancel ]

<l

Click to verify the

[<] Verify Checksum

signature of all disk
images referenced in
the DiskScript.

[<] Verify Signature
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Creating DiskScripts
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1

Create a new file with SimpleText or any word processor and enter the content of the DiskScript.
Refer to the following sections for the specific commands and syntax.

Save the file as text (the default for SimpleText).

Change the file type to “hscr” and the creator to “ddsk.”

There are many utilities that can change the type and creator of afile

DiskScript actions

Disk Copy 6.1.2 supports three actions in DiskScripts:
= Mount on the desktop all the disk images specified in the DiskScript.

» Launch an application (and optionally a document) after the specified disk
images are mounted on the desktop.

s Makefloppies from all the floppy-sized disk images specified in the DiskScript.

DiskScript syntax
Thefirst line of the DiskScript determines the action to perform:
First Line Result
<blank> Disk Copy 6.1.2 will mount all the disk images listed in the
DiskScript.
<pa thto app"cauon> ..................................................... D|S kCOpy 612W|”m0um a ” thed|sk|mages “Stedmthe

DiskScript and launch the specified application.

<path to application><tab><path to document>  Disk Copy 6.1.2 will mount all the disk images listed in
the DiskScript and launch the specified application, opening
the specified document.

<tab><tab> MAKEFLOPPY Disk Copy 6.1.2 will make a floppy from each of the floppy-
sized disk images listed in the DiskScript. If the"Make
Multiple Floppies” option is selected in the Preferences
dialog, clicking Cancel at the Insert Disk dialog will
continue to the next disk image.

The subsequent lines consist of the list of disk images to be operated upon. Only
one disk image can be listed per line.

If the target disk images are in the same folder as the DiskScript, each line can
consist of the name of a disk image without the path to it. If the target disk images
are not in the same folder as the DiskScript, the name of a disk image with the
complete path to it is required.

Alternatively, placing only acolon “ : ” in the second line of the DiskScript
instructs Disk Copy 6.1.2 to mount all images in the same folder as the DiskScript.



DiskScript features
» All filesthat are not disk images in the target folder will be ignored.
» Disk Copy 6.1.2 will resolve dliases if they point to disk images.

» If adisk image fails to mount, the DiskScript stops execution and any specified
application does not launch.

s Thedisk images listed in the DiskScript can be a mix of any size and format
supported by Disk Copy 6.1.2.

= When the application launched by the DiskScript quits, all disk images mounted
by the DiskScript will be unmounted and removed from the desktop, unless they
are in use by another application.

Sample DiskScripts

Mount and launch an application with a specific document

This script will mount all disk images in the same folder as the DiskScript and
launch the application “Installer” with the document “Installer Script,” which are
located on the disk named “Disk One.”

Di sk One:lnstaller:<tab>Di sk One:lnstaller Script

Make floppies of all disk images
This script will mount all disk images in the same folder as the DiskScript.
<t ab><t ab>MAKEFLOPPY

AppleScript support

Disk Copy 6.1.2 isfully scriptable, recordable, and attachable. To get alist of the
scripting commands available, use a script editor application to view the
AppleScript dictionary of Disk Copy 6.1.2.

Attachability is an easy and powerful way to extend the capabilities of Disk Copy
6.1.2. If thereis afolder named “ Scripts’ in the same folder as Disk Copy 6.1.2, any
AppleScript droplets or compiled A ppleScripts will appear in a* Scripts’ menu.
Disk Copy 6.1.2 will automatically detect and display any A ppleScript droplets or
compiled A ppleScripts added while it is running when brought to the foreground.
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Preferences

All preferences are stored in the “Disk Copy Prefs’ file, located in the Preferences
folder in the System Folder.

General Preferences

General Preferences...
(<] Allow User Interaction
[<] Save Log
[<] Make Multiple Floppies
[<] Confirm Erases
[<] Use Speech

Allow user interaction

When this option is selected, Disk Copy 6.1.2 will present dialog boxes when

certai n operations complete or fail, in addition to noting the result in the status
fidd. This should be turned off if Disk Copy 6.1.2 is being called by A ppleScript.
If it is not turned off, modal dialogs could appear when Disk Copy 6.1.2 isrunning,
preventing A ppleScript from continuing execution.

Save log

When this option is selected, Disk Copy 6.1.2 will write all messages presented in
the main window status field to a file named “Disk Copy Log” in the Preferences
folder in the System Folder.

Make multiple floppies

When this option is selected, Disk Copy 6.1.2 will make multiple floppies from the
same disk image. After each floppy is complete, the | nsert Fl oppy dialog box will
appear until the “Cancel” button is clicked.

Confirm erases

When this option is selected, Disk Copy 6.1.2 will present a confirmation dialog
box before erasing a floppy and copying new datato it.
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Use speech

When this option is selected, Disk Copy 6.1.2 will use PlainTak to speak dialogs
and other informational messages. T his feature requires PlainTa k Text-to-Speech.

Verification and Authentication

Uerification and Authentication...
[<] Verify Checksum
[<] Verify DigiSign Signature

[<] except DiskScripts
[<] edcept remote images

Verify checksum

When this option is selected, Disk Copy 6.1.2 will default to verify the checksum of
disk images. This setting affects the defaults of

= the Mount Image, Convert | mage, and Execute DiskScript dialog boxes

The default can be overridden by deselecting the “ Verify Checksum’ option in
each of these dialog boxes.

= any disk image operations activated by double-clicking icons or by dragging
icons to the Disk Copy 6.1.2 window or application icon

Verify DigiSign signature
When this option is selected, Disk Copy 6.1.2 will default to verify the DigiSign
digital signature of disk images. This setting affects the defaults of

= the Mount Image, Convert I mage, Make Floppy, and Execute DiskScript dialog
boxes.

The default can be overridden by deselecting the “Verify Signaturé’ option in
each of these dialog boxes.

= any disk image operations activated by double-clicking icons or by dragging
icons to the Disk Copy 6.1.2 window or application icon
Except DiskScripts

When this option is selected, Disk Copy 6.1.2 will not verify the checksum or
DigiSign digital signature of disk images referenced from DiskScripts. Disk Copy
6.1.2 will, however always verify the checksum when making a floppy.

Except remote images

When this option is selected, Disk Copy 6.1.2 will not verify the checksum or
DigiSgn digital signature of disk images that reside on AppleShare servers.

<21
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Creating Images
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Creating Images...
[<] 2ero Blocks
[<] Add DigiSign Signature
[<] Mount Afterwards

Image Exdtension: .imqg

Zero blocks

When this option is selected, Disk Copy 6.1.2 will write zeros to a newly created
disk image before writing data to it. This completely erases any residual
information that is present and will ensure optimal space savings and compression
when saving in the Read-Only or Read-Only Compressed formats. It is
recommended that this option always be selected.

Add DigiSign signature

When this option is selected, Disk Copy 6.1.2 will default to adding a DigiSgn
digital signature to newly created disk images after saving. This setting affects the
defaults of the Save Image dialog box. The default can be overridden by
deselecting the “ Add DigiSgn Signature’ option in this dialog box.

Mount afterwards

When this option is selected, Disk Copy 6.1.2 will default to mount newly created
disk images after saving. T his setting affects the defaults of the Save Image dialog
box. The default can be overridden by deselecting the “Mount Afterwards’ option
in this dialog box.

Image extension

Thisis the default extension that Disk Copy 6.1.2 will add to the name of newly
created disk images. You will see thisin the Name field of the Save | mage dialog
box.



Special Tips

Turn off “verify checksum” when mounting disk images residing on CDs

If you are going to be working with disk images that are on a CD-ROM or other
read-only media and you are sure of the integrity of the files, deselect the “ Verify
Checksum” option in the Preferences dialog for faster disk image mounting.

Not all software can be installed from mounted disk images

Some software installers look for afloppy to be in the floppy drive and cannot be
installed from mounted images. Use Disk Copy 6.1.2 to make the floppy and then
install the software

Set up Disk Copy 6.1.2 to be launched by other kinds of disk images

With System Software 7.5 or later, you can configure your computer to have Disk
Copy 6.1.2 launch when you double-click disk images created by other disk image
utilities, such as Disk Copy 4.2 and ShrinkWrap:

= The Macintosh Easy Open (or Mac OS Easy Open) control panel must be
installed.

= Remove copies of other disk image utilities and rebuild the desktop.

= Now when you double-click on a disk image created by another utility, you will
be prompted to select an application to open the file Select Disk Copy 6.1.2to
make it the default. Macintosh Easy Open (or Mac OS Easy Open) will
remember the setting and use Disk Copy 6.1.2 to open gmilar disk images.

Use the Read-Only Compressed format

The Read-Only Compressed format has a number of advantages:

= Images take up much less space, yet mount and work as fast as other disk image
formats. This can save valuable hard drive space and shorten download times.

» Storefilesin Read-Only Compressed format disk images instead of creating
archives with compression utilities; just double-click to access your files. Thisis
especially helpful for files stored on remote servers; you no longer have to copy
the archive to your local hard drive and decompressiit.
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